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Download and unzip "EN500-600 Inverter" application from our website (www.sah.co.rs) under "EN600" section.

Note: this application is only available for Windows OS.
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You can begin the installation process either by opening "setup.exe” or "EN500-600 Inverter.exe".

Installation Process

EN500-600 Inverter

Welcome to the InstallShield Wizard for

The Installshield(R) Wizard will install EN500-600 Inverter on
your computer, To continue, dick Next,

WARMING: This program is protected by copyright law and
international treaties.

< Back I MNext >L\‘3’J [ Cancel

Follow these simple steps to install the software properly.




License Agreement

Please read the following license agreement carefully.

To add your own license text to this dialog, specfy your license agreement file in the Dialog
editor,

Mavigate to the User Interface view.

Select the LicenseAgreement dialog.

Choose to edit the dialog layout.

Once in the Dialog editor, select the Memo ScrollableText contral,
Set FileName to the name of your license agreement RTF file,

[N

After you build your release, your license text will be displayed in the License Agreement dialog.

%; accept the terms in the license agreement I

[ do not accept the terms in the license agreement

InstallShield

<Back || MNext> || cancel

License Agreement

Please read the following license agreement carefully.

To add your own license text to this dialog, specify your license agreement file in the Dialog
editor,

Mavigate to the User Interface view.

Select the LicenseAgreement dialog.

Choose to edit the dialog layout.

Once in the Dialog editor, select the Memo ScrollableText contral,
Set FileName to the name of your license agreement RTF file,

[N

After you build your release, your license text will be displayed in the License Agreement dialog.

@ I accept the terms in the license agreement

(7)1 do not accept the terms in the license agreement

InstallShield

<Back | Next>,\g[ Cancel
Loy

Destination Folder
Click Mext to install to this folder, or dick Change to install to a different folder,

D Install EN500-600 Inverter to:

C:\Program Files (x86)\SAH Electronics\EN500-600 Inverter)

Installshield

[ <«Back | Nextﬁrl[ Cancel |

If you wish to change the destination folder you can do it by clicking on "Change" button.




Ready to Install the Program

The wizard is ready to begin installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard,

Current Settings:

Setup Type:
Typical
Destination Folder:
C:\Program Files {x86)\SAH Electronics\ENS00-600 Inverter)

User Information:
Mame: Iqor
Company:

InstallShield

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed EN500-600
Inverter, Click Finish to exit the wizard,

<Back Cancel

Click on "Finish" button in "EN500-600 Inverter - InstallShield Wizard"

Open Application

After installation, the shortcut with name "EN500-600 Inverter" will be created on your desktop.

Double-click to open it.



Connecting and Wiring Inverter

Wiring Power Supply

Bring the power supply to your inverter as shown.

USB Connection

| s
USB CONVERTER

|| USBTO 485 CABLE
|

|3 (B SR R
: 3 | LX08H mESsERp{s
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You need USB to RS485 converter to be connected and wired as shown on the following pictures.
Red wire -> D+/A+
Black wire -> D-/B-



Red wire -> 485+
Black wire -> 485-
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Communication Establishment

Initial Application Screen

| DR T ——n——y | |

File Settings Help
System parameter groups. s

E‘;’;“‘“" Parameter Name Set Range Min## Untt Factory Default Value Modfication
FOD - System Parameters =
FD1 - Basic Run Functions s e gty ol
FO2 - Start, Stop, Forward / Reverse, Brake e O PEE ol
FO3 - V/F Control F00.01 C-00 disply parameter selection when operstion 060 1 51 o
PO ey N i F00.02 C-01 display parameter selection when operation 060 1 2 o
FD6 - Seting Curve . -
i el M F00.03 C-02 display parameter selection when operation 060 1 4 o
F08 - On/Off Input Functions F00.04 C-03 display parameter selection when operstion 060 1 5 o
FD9 - On/Off Analog Output Functions
F10- Simple PLC/Multispesd Funciions F00.05 C-04 display parsmeter selection when operation 060 1 6 o =
F11-Close Loop PID Run Functions : 5
F12_ Congtant Pressums Wotts Sopply Furctions || 1.0 C-05 disply parameter selection when operstion 060 i 9 o
F13- Traverse/Fived Length Cortrol Functions | F00.07 C-00 display parameter selection when stop 060 1 2 o
F14.- Vector Cortrol
F15.- Asynchronous Motor F00.08 C-01 display parameter selection when stop 060 1 6 o
L1t Glosed L oo Encodcy FO0.09 C-02 displ ter selection when si 060 1 a8
F18 - Enhance Control S DN Ao SeCONOT Wi P &
F19 - Protective Relevant Functions FoD.10 C-03 display parameter selection when stop 060 i 14 o
F20 - Intemal Virtual InputOutput Node:
F25 - User Definition Display FI0.11 C-04 display parameter selection when stop 060 i 2 o
EZE ol Ficord Flcare F00.12 C-05 display parameter selection when stop 060 1 3 o

F00.13 Fower-on fauit moritor parameter selection 05 1 0 o

FOD.14 Parameter operafion corrol 000452 i 000 x

FO0.15 Button function selection 0000-1151 i 0001 o

FO0.16 Mukifunction key run command channel switching arder selection 03 1 0 o

FO0.17 Motor speed display coefiicient 0.17999.9% 0.1% 100.0% o

F00.18 Line: velocity display coeficient 0.1~999.9% 0.1% 10% o -
Frequency Seftings Operafions. Monitor Parcmeters Table View Meaning of modiication values

0.00 [E The inverter of device with ID = 1 wil respond to these commands. Frequency: Graph View x— Parameter cant be changed in process of running
. Hz
RS Graph Setin — Parameter can be changed of
[E [Crowar®06 ) (5161 [Cromadfn.] Motrs : soph Setings 0 — Parameter can be changed in process of unning
* — Read-only parameter, unmodfisble
SET [ Revemedos | [ s10P | [ ReveseFun | DC_BUS:
Seral Port Sektings Aun Information Current:
Output Voltage:
STOP
P Output Power:
Refresh Rae s}

After opening you'll get this initial screen.

Note: width and height of this window may vary depending on the dimensions of your monitor, because the app
starts in full screen mode by default.

Change Language

File [ Settings

Systen 7] Inverter 1D o
E‘;"‘f“’" Parameter Name Set Range Ming# Unit Factory Default Value Modfication

o -

Fo1 Parameter group display control

FO2 - Seat, Stop, Forward / Revarsé, Brake ittt i

FO3 - WF Contral FOO0.01 C-00 display parameter selection when operation 060 1 51 o

FO4 - Aupdliary Rur

et [N F00 02 C-01 display parsmeter selection when operstion 060 1 2 o

FU6 - Setting Curve

e F00.03 €02 display parameter selection when operation 050 1 4 o

FO8 - On/Off Input Functions FO0.04 €03 display parameter selection when operstion 050 1 5 o

FU9 - On/Off Analog Output Functions

F10 - Simple PLC/Mutispeed Functions FO0.05 €04 display parameter selection when operstion 050 1 [ o =

F11 -Close Loop PID Run Functions 5

F12- ot Prodours Watm oty Funcions || P06 C-05 display parameter selection when operation 060 1 9 o

F13 - Traverse/Foced Length Cortrol Functions || F00.07 C-00 display parameter selection when stop 060 1 2 o

F14 - Vector Cortrol

F15 - Asynchronous Moter F00.08 C-01 display parameter selection when stop 060 1 6 -

F16 -Closed Loop Encoder

F18 - Erhance Cortrel F00.09 C-02 display parameter selection when stop 060 1 48 o

F19 - Protective Relevant Functions F0O0.10 C-03 display parameter selection when stop 060 1 14 o

F20 - Intemal Virtual Input/Output Node:

F25 - User Defintion Display FO0.11 C-04 display parameter selection when stop 050 1 2 o

£25 ok Hecor) aictons F00.12 C-05 display parameter selection when stop 060 1 3 o
F0013 Fower-on fault moritor parameter selection 5 1 0 o
FO0.14 Parameter operation cortrol 000452 1 000 x
F00.15 Button function selection 0000-1151 1 0001 o
F00.16 Muttifunction key run command channel switching order selection 03 1 o o
FO0.17 Motor speed display coefficient 0.17999.9% 01% 100.0% ]
F00.12 Line velocty display coefficient 0.1-939.9% 0.1% 1.0% ° .

Frequency Setings Operations Monttor Parameters Table View Meaning of modfication values

0.00 @ ‘The inverter of device with ID = 1 wil respond to these commands. Frequency: Graph View x — Parameter cant be changed in process of running
- Hz
A — Graph Settn ~— Parameter can be changed o
[roward 106 ) [__staRT_] [ Fomeriiun_ Motor Speed: raph Setings 0 — Parameter can be changed in process of running
*— Read-only parameter, unmodfiable
SET [RevenedoG | [ sT0P | [ Revese Run | DC_BUS:
Serial Port Seftings Run Information Current:
Curent settings: i
e Output Voltage:
p Output Power.
o it ],

The language is set to English by default.

If you need to change the language, go to Settings -> Language.



Setting Serial Port Parameters

/600 Tnverte
File Settings Help
System parameter groups -
E‘;g:'“" Parameter Name Set Range Ming# Urit Factory Defaut Value Modification —
FO1 - Basic Run Functions FOD.OD Parameter group display corirol 03 1 2
FO2 - Start, Stop, Forward / Reverse, Brake. Sde R el s <
F03 - V/F Control FO0.01 C-D0 display parameter selection when operation 060 1 51 o
FOA - Avsdiery Runri
T Ct s Frviciness F00.02 C-01 display parameter selection when operaion 060 1 2 o
FO§ - Setting Curve
P e Frsia F00.03 C-02 display parameter selection when operation 060 1 4 o
FO8 - On/Of Input Functions FO0.04 C-03 display perameter selection when operation 060 1 5 o
FI3 - On/Of Anslog Output Functions
F10- Smple PLC/Mutispeed Functions F00.05 C-D4 display parameter selection when operation 060 1 6 o =
F11 - Close Loop PID Aun Functions
FI2 - G Brsoure ok Somly Functions || P05 C-05 display parameter selection when operation 060 1 9 0
F13 - Traverse/Foed Length Cortrol Functions | F00.07 C-00 display perameter selection when sop 060 1 2 o
F14 - Vector Control
F15 - Agynchronous Motor F00.08 C-D1 display parameter selection when sop 060 1 B o
F16 - Closed Loop Encod
e b d et FO0.09 C-02 display parameter selection when siop 080 1 4 o
F19- Protective Relevant Functions FO0.10 C-03 display parameter selection when stop 060 1 14 o
F20 - Ifemal Vitual Input/Ovtput Node:
725 - User Defirtion Display F00.11 C-04 display perameter selection when stop 060 1 20 o
F26; FakFacard Finctiors F00.12 €05 display parameter selection when stop 060 1 B} o
F00.13 Power-on faut montor paremeter selection s 1 1] o
FO0.14 Parameter operstion control 000-452 1 00 x
FO0.15 Button function selection 00001151 1 0001 o
FO0.16 Mutifunction key run command channel switching order selection 03 1 ] 0
F00.17 Mctor spesd display cosfficient 0.17999.9% 0.1% 1000% o
F00.18 Line velocky display coefficient 0.1~999.9% 0.1% 10% o =
Frequency Settings Operations Moritor Parameters @ Table View Meaning of modiication values
0.00 i The inverter of device with 1D = 1 will respond to these commands. Frequency: Graph View x — Parameter cant be changed in process of running
g Hz [¥] [LFowa 06 [L_5TART. ] [ Fomerfun] Motars e Graph Settings 0 — Parameter can be changed in process of runring
SET [ Revese0G | [ STOP | [ RevemeRun | = = Greph parameters * — Read-only parameter. unmadfizbie
DC_BUS: =
- 0~
2 ]
Serisl Port Settings Fun Information Current: J @
Current settings:
e Qutput Voltage:
ﬁ QOutput Power:
Opens the new window with essential port settings (COM port, baud rate, etc) | il A0

In order to establish the communication between the inverter and your computer, you have to set the essential port
parameters.

Click this button to get "Communication" window.

Check COM Port Conection

| s

4 24 Igor-PC
i+ Computer
-a Disk drives
lf!'i Display adapters
-4 DVD/CD-ROM drives
L% Hurnan Interface Devices
- IDE ATASATAPI controllers
-Z& Keyboards
--ﬂ Mice and other pointing devices
.jl:y Menitors I
-EF Network adapters |
-|[l5y Other devices
i PCISerial Port
¢ |l PCISimple Communications Controller
.Y Ports (COM & LPT)
f? Communications Port (COML)

Ff? Printer Port (LPT1)
7' USB-SERIAL CH341A (COM4) |

R Processors L}
-%| Sound, video and game controllers
M System devices
-1 Universal Serial Bus controllers

Rl O~ - A ~ 0~ e -

To check which port is your device connected to, follow the next steps:

(1) On your Windows menu go to Control Panel -> Device Manager

(2) Expand "Ports (COM & LPT)" item to get the list of all ports connected to your computer
(3) Find your serial port (usually it is marked as "USB-SERIAL CH341A")

(4) Notice the port label in brackets (COM + port number)



(5) Go back to your communication settings and select the noticed port

Select COM Port

i hl
& Communication ==

Serial Port

In "Communication” window click on "Port" drop-down combo box to get the list of all available COM ports on your
computer.

Note: when you launch the application for the first time this combo box will be empty; once you define this
parameter it will be used as default every next time you start the app.

Select Baud Rate

-
o-! Communication

Serial Port

L — —— — = ——

By default baud rate configuration parameter is set to 9600.

Check for the default value of this parameter in Help -> User manual (Chapter 6.2 -> Default value of function
F05.01).

Select Data Format

r E hl
ol Communication Iil_lg

Serial Port

By default data format configuration parameter is set to 8.

Check for the default value of this parameter in Help -> User manual (Chapter 6.2 -> Default value of function
F05.02).

Select Parity Checkout

-
ot! Communication

Serial Port

Port: Baud: [Bﬁm v] Data: IB VI

ks — — — = —

By default parity checkout configuration parameter is set to None.

Check for the default value of this parameter in Help -> User manual (Chapter 6.2 -> Default value of function
F05.02).



Save Your Settings

- r Bl

a5l Communication lilﬂlg
Serial Port

L ———— ——

Click OK to save your communication settings and go back to the main screen

Open Port

File

Settings  Help

System parameter groups

FOD - System Parameters
sic Run Functions

FO3 - V/F Cartrol

FO4 - Ausslary Runring

F05 - Teminal Cormelative Functions
F0 - Setting Curve

FO7 - Analog, Puise Input Functions
F08 - On/Of Input Funcions

F09 - On/Off Anzlog Output Functions
F10 - Smple PLC/Mukispesd Functions
F11-Close Loop PID Run Functions
F12-Cor

F14- Vector Cortrol

F15 - Asynchranous Motor
F16 - Closed Loop Encoder

F18 - Enhance Control

F13 - Protective Relevant Functions
F20- Intemal Virual Input/Output Node
F25 - User Definition Display

F26 - Fault Record Functions

FO1 - Basic
F02 - Start. Stop. Foward / Reverse. Brake

nstart. Pressure Water Supply Functions
F13- Traverse/Fixed Length Control Functions

Function
Code

Frequency Setings
ann G
0.00
Hz B
SET

Seral Port Setfings

£

Curent settings:

Parameter Name

Parameter group display corirol

C-00 display parameter selection when operation
C-01 display parameter selection when operation
C-02 display parameter selection when operation
C-03 display parameter selection when operation
C-04 display parameter selection when operation
C-05 display parameter selection when operation
C-00 display parameter selection when stop

C-01 display parameter selection when stop
C-02 display parameter selection when siop
C-03 display parameter selection when stop
C-04 display parameter selection when stop
C-05 display parameter selection when siop
Power-on fault monitor parameter selection
Parameter operation cortrol

Button funciion selection

Mutti function key run command channel switching order selection

Motor speed display coefficiert
Line velociy display coefficiert

The inverter of device with ID = 1will respand to these commands.

COM4 9600.None. 8.1

[ FowadsoG ] [ START | [ ForwardRun |
[ Revewed0G | [ 510 | [ RevereRun |
Fun Irfomation
STOP

| Close Port|

T Opens the port with given settings.

[
000-452
0000-1151
03
0.17999.9%
0.17999.9%
Maniter Parameters

Frequency:

Motor Speed

DC_BUS

Current:

Output Voltage:

Output Power:

Refresh Rate [ms]

Table View

Graph View

Graph Settings

Graph parameters

..G)

]

Min#t Unit Factory Default Value

1 51

1 s

1 4

1 %

1 6

1 9

1 2

1 6

1 48

1 14

1 20

1 9

1 0

1 000
1 0007
1 )
0.1% 100.0%
0.1% 10%

Meaning of modfication values
x — Parameter cant be changed in process of running
& — Parameter can be changed in process of urring

*— Read-only parameter. unmodfiable

Modfication

Click on "Open Port" button to establish the communication between the inverter and your computer.

Connection Established

500/600 Inverte: i
File Settings Help
System parameter goups .
E‘;’;“‘“" Parameter Name Set Range Min## Untt Factory Default Value Modfication
=
FO1 - Basic Run Functions e o s ol
FO2 - Start, Stop, Forward / Reverse, Brake HenS g pC el D
FO3 - V/F Control FI0.01 C-00 display paremeter selection when operation 060 1 51 51 o
EE i #‘:ﬁ,‘li’; Eﬂ”&;ﬁve Fivictionis FO0.02 C-01 display parameter selection when operation 060 i 2 2 o
FD5 - Setting Curve " -
e FI0.03 C-02 display parameter selection when opergtion 00 1 4 4 o
FO8 - On/Of Input Function: FO0.04 C-03 display parameter selection when operation 060 1 5 5 o
F09 - On/Of Analog Otput Functions
F10 - Simple PLC/Mut-speed Functions FO0.05 C-04 display parameter seloction when operation 040 1 6 5 o =
F11 -Close Loop PID Run Functions - 3
F12 ot o oo Weter Somsly Furctions || FI008 C-05 display paremeter selection when operation 060 1 9 3 o
F13 - Traverse/Fixed Length Control Functions | 00,07 C-00 display parameter selection when stop 060 1 2 2 o
F14 - Vector Cortrol
F15- Asynchronous Motor F10.08 C0 display parameter selection when stop 00 1 8 € o
51 Cosed Lo Ercodcr FO0.09 C-02 displ ter selection when si 060 i a8 48
F18 - Enhance Control ekl abdisieborecanlll 0 L
F19 - Protective Relevant Functions Fo0.10 C-03 display parameter selection when stop 060 1 14 14 o
F20 - intemal Vitual Input/Otput Node
F25 - User Definition Display FO0.11 C-04 display parameter selection when stop 060 1 2 2 o
EZ o Bacord Pl cane F00.12 C-05 display parameter selection when stop 060 1 3 9 o
F10.13 Fower-on fauit moritor parameter selection s 1 0 o
FOO.14 Parameter operation control 000-452 1 000 000 x
FO0.15 Button function sslection 00001151 1 0001 [ o
FI0.16 Mutifunction key run command channel switching order selection 03 1 0 0 o
FO017 Motor speed display coefficient 0.17999.9% 01% 100.0% 100.0% o
F10.18 Line: velocity display coeficient 0.1~889.9% 01% 10% 10 o .
Frequency Settings Operations Monitor Parameters Fodn Vews Meaning of modfication values
i 35.00 [E The inverter of device with ID = 1 wil respond to these commands Frequency: 0.00 Hz ) Graph View x— Parameter cant be changed in process of running
. Hz
[E [Crowar 06 (5181 [Cromadfn.] Motor S L T Graph Settings 0 — Parameter can be changed in process of unning
SET e —— *— Read-only parameter, unmodfiable
[ Revemetos | [ s10P | [ Revese ] DC_BUS: T
Seral Port Seftings Aun Information Current: RA
LoEas Output Voltage: ov
COM4 9600 None sSTOP Pt ge:
P | Output Power: 0w
oo |
Refresh Rate fms}:

If the progress bar above the port buttons become green, the connection is established successfully and the main

parameters are loaded from the inverter (colored in red).

If the error message is shown, then you should go back to the previous steps and check if you set the serial port




parameters properly.

Application Features

Switch Between System Parameter Groups

File Settings Help

System paremeter groups: ]
Ll b F&‘f’f‘“” Parameter Name Set Range Min# Uit Factory Defaul: Value Modfication
Parameters &
Fun Func M T ey ol el
T Main frequency input channel selection
/F Cortrol FO1.01 Main frequency digital setup 0.00Hz"upper it frequency 001H: 50.00Hz 5000Hz o
F04 - Audlary Runin
e i e F01.02 Main frequency digital corirol 000-111 (Orly when F01.00=0:3:2) 1 w0 w0 o
F0 - Setting Curve
e e Fei F01.03 Aupiliary frequency input channel select 020 1 2 2 o
F08 - On/Off Input Functions FO1.06 Aupilary frequency digital sefup 0.00Hz"upper limit frequency 001H: 0.00H: 00H: o
F09 - On/Off Analog Output Functions =
F10 - Smple PLC/Nti speed Functions F01.05 Ausilary frequency digital cortrol 0011 1 il n o s
F11 -Cose Loop PID Run Functions
F2- o Drsare et Supoty Furtons. | IFC1-26 Main and auliary provide calculating setup o7 1 0 0 o
F13 - Traverse/Ficed Length Cortrol Funciions | {F01.07 Ausitary frequency provide cocfficiert 000~10.00 001 100 1.00 o
F14 - Vector Cortrol
F15 - Asynchronous Motor F01.08 Coefficient after complex of main and audiary frequency 000-10.00 001 100 1.00 o
F16 - Closed Loop Encodk
3t E:f‘am EZmu\m = F01.09 Ausdliary frequency range selection 01 1 0 0 o
F15 - Protective Relevant Functions F01.10 Aundliary frequency source scope 0.0071.00 001 1.00 100 o
£20 - Intemal Virtual Input/Output Node
£25 - User Definiion Display FO1.11 Upper mt frequency Low lmt frequency™~600.00Hz 001H: 50.00Hz 5000H:  |x
2B S R FO112 Low imit freauency 0.00Hz"upper Imit frequency 001H 040H 04 [x
F01.13 Low mt frequency run mode 03 1 2 2 x
FO1.14 Sleep run hysteress frequency 0.01Hz"upper i frequency 001He 001H 00tHz o
F01.15 Run command channel selection 02 1 L] 2 0
F01.16 Run direction setup 0000-1121 1 1000 1000 0
F01.17 Acceleration time 1 160000 1 Based on motortype 100 0
F01.18 Deceleration time 1 1~60000 1 Based on motor ype 100 o -
Frequency Settings Operstions Monitor Parameters Meaning of medfication values
35 00 E The inverter of device with |D = 1 wil respond to these commands. Frequency: 0.00 Hz ©) Graph View x — Parameter cant be changad in process of nunning
2 Hz [¥] [Lrowari 06 [__START. ] (L FomadFun ] Molor Speed:  ORPM Graph Settings 0 — Parameter can be changed in process of unring
; T ||
SET [[Revese 0G| [__5T0P_] [ Revemefun | e ey reph parameters | *— Read-ory parameter unmodfiable.
. L %)
Serial Part Seings Run Infomation Current: BEA | @]
Currert seffings: Output Voltage: ov
‘COM4 9600,Nore. P! ge:

ﬁ w——— Output Power: 0w
[ Open Port | [ Close Pt

Refresh Rate fms]

You can choose what functions to be shown in the table by clicking on desired system parameter group from the
list.

This operation takes a few seconds.

Parameter Modify

500/600
File Settings Help

System parameter groups -
P L ‘ E:g‘:‘“” Parameter Name Set Range Min## Unit Factory Defaut Value Modfication —
(=] F01.00 Main fr ut channe! selecti 03 1 0 4
F02 - Stat, Stop, Forward / Reverse. Brake el bttt e b o 2
FO3 - V/F Control FO1.01 Main frequency digtal setup 0.00Hz upper limit frequency 001Hz 50.00Hz 5000Hz o
F04 - Andiary Running
FO5 - Temminal Conclaihve Functions FO1.02 Main frequency digital cortrol 000111 (Only when FO1.00=0:3:4) 1 o [ o
FOE - Setting Curve
O ek P s F01.03 Audlary frequency input channel select 020 1 20 20 o
FO& - On/Off Input Functions FO1.04 Audliary frequency dighal setup 0.00Hzupper limit frequency 0.01Hz 0.00Hz 0.00Hz o
F09 - On/Off Analog Output Functions
F10 - Smele PLC/Mukispeed Functions FO1.05 Audlary frequancy digtal control 0011 1 1 1 o
F11 -Close Loop PID Run Functions
P D e Sonoiy Firiors [1F0108 Main and audiary provide calculting setup 07 1 ] 0 o
F13 - Traverse/Fixed Length Control Functions | F01.07 Audlary frequency provide coefficiert 000-1000 001 100 1.00 o
F14 -Vector Cortrol
F15 - Asynchrenous Motor FO1.08 Coefiicient after complex of main and ausdiary frequency 000-1000 001 100 1.00 o
I dedlow b FOL0S | Auilanyfrequency range selection o1 1 [ [] o
F19- Frotective Relevant Functions F01.10 Auiiary frequency source scope 0.00~1.00 0.01 1.00 1.00 o
F20 - Intemal Virtual Input /Output Node
F25 - User Defintion Display Upper limit frequency Low limit frequency™~600.00Hz
F2b Tl oot Funcharss FO1.12 Low limit frequency 0.00Hzupper limit frequency ¢ D01H:z 0.40Hz 040Hz  |x
F01.13 Low limit frequency run mode 03 1 2 2 x
FO1.14 Sleep run hysteresis frequency 0.01Hz upper limit frequency 001Hz 0.01Hz 0.01Hz o
F01.15 Run command channe! selection 02 1 o 2 -]
F01.16 Run dirsction setup 0000-1121 1 1000 1000 o
F01.17 Acceleration time 1 1760000 1 Based on motortyps 100 ]
FO118 Decsleraton time 1 160000 1 Based on motortype 100 o o
Frequency Settings Operations Monitor Parameters Meaning of modfication values
15.65 [E The inverter of device with 1D = 1 wil respond to these commands. Frequency: 0.00 Hz @ Gaph View X — Parameter cant be changed in process of unning
G Hz 3] [Croweiv05..) [sTaRT.) [LrowaRn.) s Graph Settings 0 — Paremeter can be changed in process of ninring
. e |
SET [(RevesedoG | [__s1op | [ Reverse Run | B e TS | Grephpammeies | *— Read-riy parameter, urmodiable
> . | o= |
. |
Serial Port Settings Run Information Current: 0.0A ‘ ‘7@ |
Curert sefiings: Output Voltage: ov

COM4 9600.Nore.8.1 - STOP
ﬁ e OutputPower ow
| Close Port

[~ Open Pot

Refresh Rate frs]

Double-click on desired row in the table to modify the value of selected parameter.

"Parameter Modify" window will be opened.



In this menu you can modify the value of selected parameter.

g5 Parameter Modify - M

Enter the desired value within the shown setting range.

Note: if the parameter is read-only or not modifiable in current inverter running status, this field will be disabled.

BE Parameter Modify -

Confirm your changes by clicking OK button.



ENS00/600 Inver oo | S

File Settings Help
System parameter groups =

Rncion  parameter Hame Set Range Min# Unic Factary Defaut Value Modfication
F00 - System Parameters a
£0 Fun Functions
T F01.00 Mainfrequency input channel selection 03 1 0 4 o
F03.-V/F Control FO1.01 Mainfrequency dgtal setup 0.00Hz"upper Imit frequency 001z 50.00Hz 5000H: o
FO4 - Audiary Runring
FO5 . Toomin Conelote Firictions FO1.02 Main frsquency digtal cortrol 000111 (Only when F01.00-0:3:4) 1 w [ o
F06 - Setiing Curve
e e il FO1.08 Ausilary frequency input channdl seloct 020 1 2 2 °
FO8 - OnvOff Input Functions FO1.04 Audlary frequency digtdl setup 0.00Hz"upper lmit frequency 001H: 0.00H: 0H: o
F09 - On/Off Analog Output Functions 4
F10 - Smele PLC/Mlispeed Functions FO1.05 Auilary frequency digtal cantrol 0011 1 1 1 o
F11 - Qlose Loop PID Fun Functions
P D e e e e Sonoyy Fuions[1F0108 Main and audiary provide calculating setup 07 1 ] [] o
F13- Traverse/Fxed Length Cortrol Functions | F01.07 Auilary frequency provide coefficiert 000~ 1000 001 100 1.00 o
F14 -Vector Cortrol
F15 - Asynchrenous Motor FO1.08 Coefficient after complex of main and ausdiary frequency 0001000 001 100 1.00 o
[ diow b FOL0S | Audlanyfrequency range selection o1 1 [ [}
F19 - Frotective Relevant Functions FO1.10 Aundlary frequency source scope 0.00~1.00 001 1.00 1.00
F20 - Intemal Vitual Input Output Node L4
B e T T P e oo Jown v
F2b Tl oot Funcharss FO1.12 Low limit frequency 0.00Hzupper limit frequency 0.01Hz 0.40Hz 0.40Hz

FO113 Low limit frequency run mode 03 1 2 2 x

FO114 Sleep run hysteresis frequency 0.01Hz" upper lmit frequency 001H: 001k 0H o

FO1.15 Fiun command channel selection 02 1 0 2 o

FO116 Fun direction setup 00001121 1 1000 1000 o

FOL17 Acceleration time 1 160000 1 Based on motortype | 100 o

FO118 Decsleraton time 1 160000 1 Based on motortype | 100 ° -
Frequency Settings Operations Montor Parameters Table View Meaning of modfication values

3500 o @ The inverter of device with 1D = 1 will respond to these commands. Frequency: 000Hz *) Graph View - Parameter canl be chranged in process of running
- z
R — Graph Settings 0 — Parameter can be changed in process of iy
) [ Fomers0G | [ START | [ FowerdFun | Motor Speed:  DRPM e pa il 2
B | Graph paramsters * — Read-only parameter, unmodiiable
[ ser | —————— | ‘
o
. |
ol P St T Current: 00A | | @ |
Curert settings: - ov
il o STOP Output Voltage: ov
ﬂi = = OutputPower ow
o o |
Refresh Rate fms]

Your changes should be seen in the table after few seconds.

Otherwise, you'll get the warning message, which means that you didn't enter the valid value (not formatted
correctly or value out of setting range).

Adjust Frequency Settings

Frequency Settings Operations

i The inverter of device with 1D = 1+
3500 Hz E?ncrementsthefrequencyvalue by 1 i

)

Increment the value of setting frequency by 1 (if it doesn't exceed the upper limit frequency)

Frequency Settings Operations

36.00

The inverter of device with ID = 1w

@
TR (el

[ Decrements the frequency value by 1 E

Decrement the value of setting frequency by 1 (if it is not less than low limit frequency)

Frequency Settings

35.00

Also you can enter the value manually.



Set Frequency

Frequency Settings

15.65
SET

Hz

Operations

The inverter of device witl

Forward JOG
Rewverse JOG

[ Sets the given frequency value to the inverter ]

Click SET button to assign the given frequency value to the inverter.

Information |_ ® |
Input frequency is set to value 15,65 Hz
OK

You'll be notified that the value has been set to the given value successfully.

Start The Inverter

File Settings Help

System parameter groups

FO2 - Stant. Stop. Forward / Reverss. Brake

F03 - V/F Control FO101
F04 - Aundlary Running

F05 - Terminal Correlative Functions EOTE
F06 - Setting Curve F01.03
FQ7 - Analog, Pulse Input Functions

F08 - On/Off Input Functions FO1.04
F09 - On/Off Analog Output Functions

F10 - Simple PLC/Multi-speed Functions F01.05
F11 - Close Loop PID Run Functions P

F12 - Constant Pressure Water Supply Functions
F13 - Traverse/Fieed Length Cortrol Funciions | F01.07
F14 - Vector Cortrol
15 - Asynchronous Motor F01.08
F16 - Closed Loop Encoder
F18 - Enhance Cantrol

F19 - Proteciive Relevant Functions FO1.10

F20 - Intemal Virtual Input Output Node
£25 - User Definiion Display FOL11
F26 - Fault Record Functions

Function b ameter Name
FOD - SE em Parsmeters Code
e Main frequency input channel selection
Main frequency digital setup
Main frequency digital control
Ausdiliary frequency input channel select
Ausdliary frequency digital setup
Ausdliary frequency digital control
Main and auwdliary provide calculating setup
Audliary frequency provide coefficiert
Coefficiert after complex of main and audliary frequency
F01.09 Audliary frequency range selection
Aundliary frequency source scope
Upper mt frequency

FO1.12 Low limt frequency

FO1.13 Low it frequency run mode

FO1.14 Sleep run hysteresis frequency

F01.15 Run command channel selection

FO1.16 Run direction setup

F01.17 Acceleration time 1

F01.18 Decsleration time 1
Frequency Settings Operations Monitor Parameters
W H E The inverter of device wih 1D = Twil respond to these commands. Frequency:

< [+] [ Fomardioc [J sTaRT |)[ Forward Fun Motor Speed:

[ Reverse 06 ] [__STOPStorts the inveter n default rotate direction |

Serial Port Settings

Current settings:
COM4 9600.None.8,1

J Open Port

Run Information

Current:
QOutput Voltage:
Output Power:

Refresh Rate fms]

Set Range
09

0.00Hz"upper it frequency
000-111 (Orly when F01.00=0:3:2)
020

0.00Hz"upper imit frequency
0011

07

000-10.00

000-10.00

01

00071.00

Low lmt frequency™~600.00Hz
0.00Hz"upper it frsquency

03
0.01Hz"upper i frequency
02
00001121
160000
1+60000
0.00 Hz ©) Graph View
A Graph Settings
E Graph parameters
3225V
2 o=
00A . ®
ov
ow

Ming# Unit Factory Defaul Value

0.01H: 50.00Hz 50.00Hz
1 ] 00

1 2 20
0.0TH: 0.00H: 0.00H:
1 il n

1 0 [}

001 100 1.00
001 100 1.00

i 2 0

001 100 1.00
D.01Hz 50.00Hz 50.00Hz
D.01Hz 040H 0.40H
1 2 2
D.01Hz 001H 0.01Hz
3 ] 2

i 1000 1000

1 Based on matortype 100

1 Based on motortype | 100

Meaning of modfication values
x— Parameter cant be changd in process of runring
0 — Parameter can be changed in process of running

- — Read-oniy parameter, unmodfizble

Modfication

] | |

o

o

o

o

m

Click on START button to start the inverter in default rotate direction.

Note: if nothing happens, check if F01.15 is set to value 2.




File

Settings  Help

System parameter groups

F00 - System Parameters
£01 -Basic Run Functions

F02 - Start, Stop. Forward / Reverse, Brake
F03 - V/F Cortrol

FO4 - Ausdiary Runring

05 - Terminal Comelafive Functions

FU6 - Setting Curve

F07 - Anelog, Pulse Input Functions

F10 - Simple PLC/Mulispeed Functions
~Close Loop PID Run Funcions

F12-Constant Pressure Water Supply Funcions

F13 - Traverse /Fixed Length Control Functions

F14 - Vector Cortrol

F15 - Asynchronous Motor

F16 - Closed Loop Encoder

18 - Enhance Control

F19 - Protective Relevant Functions

F20 - Itemal Virtual Input/Otput Node:

£25 - User Definiion Display

F26 - Fault Record Functions

‘ functon parameter Name Set Range Wint Unit Factory Defauk Value Modication
F01.00 Meain frequenoy input channel selection 08 1 [ 4 o
F01.01 Msin frequency digtl setup 0.00Hz"upper it frequency 0.01H:z 5000 000H: |0
F01.02 Msin frequency digtal cortrol 000-111 Orly when FO1 00-0-34) 1 0 0w o
F01.03 Audiary frequency inpt channel select 02 1 2 2 o
FO1.04 Ay requency digtl setup 0.00Hz"upper it fraquency 001H:z 0.00H: 000 |o
F01.05 Pusdisy frequency digtal cortrol 0011 1 it n o
F01.06 Main and awslar provide calculating setup 07 1 ] 0 o
F01.07 Aupdisy requency provide cosficiet 000~10.00 o001 100 100 o
F01.08 Coefficient after comples of main and auliary freauency 0001000 001 100 100 o
F01.09 Pusdiay frequency range section 3] 1 ] 0 o
Fo1.10 Aupiisy requency saurce scope 000~100 001 100 100 o
FoL1 Upperlinit frequency Low It frequency™600.00Hz 001H: 50.00Hz 5000H  [x
Fo1.12 Low It frequency 0.00Hz"Upper imt frequency 001Kz 040H: 2 |x
FOL13 Lowimt frequency run mode 03 1 2 2 x
FO1.14 Sleep run hysteresi frequency 0.01Hz"pper it frequency 0.01H: 0.0TH: 00 o

FO1.16 Run direction setup
F01.17 Acceleration time 1
FO1.18 Deceleration time 1
Frequency Settings Operations
1 5 56 E] The inverter of device with 1D = 1 will respond to these commands
- Hz
[ FowadJog | [ START | [ FowadRun |
SET [ Revemed0G | [ s10P | [ Revesefun |
Seral Port Settings Run Informatian
Current settings:
COM4 9600, Nore 8.1 START
p Open Port Rotate Direction: Forward e

Monitor Parameters
Frequency:
Motor Speed:
DC_BUS
Current:

OQutput Voltage:
Output Power:

Refresh Rate fms]:

00001121
1-60000
1~60000

15.56 Hz

466 RPM
Graph parameters

3208V

02A

nv

014w

1 Based on motortype 100
Based on motortype | 100

Meaning of modfication values

x — Parameter cant be changed in process of nunring

0 — Parameler can be changed in process of unning

* — Read-only parameter, unmodiiable

Run information should be changed from STOP to START and the Rotate Direction label will appear.

Also you will notice that Monitor Parameters are changing by the chosen refresh rate interval (by default 1000 ms)

Parameter Name

Main frequency input channel selection
Main frequency digtal setup

Main frequency digtal cortrol

Ausdlary frequency input channel select

Audiary frequency digtal setup

Ausliary frequency digtal cortrol

Main and auliary provids calculating setup

Audliary frequency provide coefficient

Coefficient after complex of main and audiary frequency
Auliary frequency range selection

Auiliary frequency source scope

Upper i frequency

Low fimit frequency

Low limit frequency run mode

Sleep run hysteresis frequency

Run command channel selection

Run direction setup

Acceleration time 1

Deceleration time: 1

The inverter of device with |D = 1 wil respond to these commands.

[ Fomadtos | [ sTART

[ Forward Run |

[ Revesedo | [

sop_||[ Revene Aun |

Run Information

START

File Settings Help
System parameter groups Firction,
FOD - System Parameters Lok
F01 - Basic Fun Functions
F02 - Star, Stop, Forward / Reverse,
F03 - V/F Control FOLO1
FO4 - Audiary Runring
FO5 - Terminal Comelative Functions FO1.02
F0 - Setiing Curve F01.03
FO7 - Analog. Pulse Input Functions
FO2 - On/Off Input Functions FO1.04
F09 - On/Off Analog Ouiput Funcions
F10 - Simple PLC/Mukispeed Functions F01.05
F11 -Cose Loop PID Run Funclions 0106
F12 - Constant Pressure Water Supply Functions
F13 - Traverse/Fixed Length Cortrol Funcions | FO1.07
F14 - Vector Cortrol
F15 - Asynchronous Motor FO1.08
£16 - Closed Loop Encoder ey
F18 - Enhance Control -
F19 - Frotective Relevant Functions FO1.10
£20 - Intemal Virtual Input /Ouitput Node
£25 - User Defintion Display FOL11
F26 - Fault Record Functions =
FO1.13
FO1.14
FO1.15
FO1.16
FO1.17
F01.18
Frequency Settings Operations
1556 he
SET
Serial Port Seffings
Current settings:
COM4 9600.Nore 8.1
J Open Port | [ Close Port

[Rotale Direction: Reverse

<)

Monitor Parameters
Frequency:
Motor Speed:
DC_BUS:
Current:

Output Voltage:
Output Power:

Refresh Rate fms]:

Set Range

0.00Hz"upper it frequency
000111 (Only when F01.00-0:3:4)
020

0.00Hz"upper mit frscusncy
0011

07

000-10.00

000-10.00

01

00071.00

Low limitfrequency™~600.00Hz
0.00Hz"upper it frequency

03

0.01Hzupper imit frequency

02

0000-1121

160000

160000
15.56 Hz
e Graph Seftings

Graph parameters
3208V
0

02A L ®
70V
014w

Min# Unit Factory Default

0.01Hz 50.00Hz
1 ®

1 2

D.01He 0.00H

1 il

1 2

001 1.00

001 1.00

i ]

001 100

001H: 50.00Hz

0.01H: 040H:

1 7

00TH: 001H:

i 0

1 1000

1 Based on motor type
1 Based on metor type

Mearing of modfication values

x — Parameter cant be changed in process

* — Read-only parameter, unmodiable

Value

e e |

00Hz

=]
&

8

of running

— Parameter can be changed in process of running

Modication |~

o

o

m

Click on "Forward Run" or "Reverse Run" button to change between forward and reverse rotate direction.

The change will be displayed in Run Information group box.




File

Settings  Help

System parameter groups

F00 - System Parameters
£01 -Basic Run Functions

F02 - Start, Stop. Forward / Reverse, Brake
F03 - V/F Cortrol

FO4 - Ausdiary Runring

05 - Terminal Comelafive Functions

FU6 - Setting Curve

F07 - Anelog, Pulse Input Functions

F10 - Simple PLC/Mulispeed Functions
~Close Loop PID Run Funcions

F12-Constant Pressure Water Supply Funcions

F13 - Traverse /Fixed Length Control Functions

F14 - Vector Cortrol

F15 - Asynchronous Motor

F16 - Closed Loop Encoder

18 - Enhance Control

F19 - Protective Relevant Functions

F20 - Itemal Virtual Input/Otput Node:

£25 - User Definiion Display

F26 - Fault Record Functions

‘ functon parameter Name Set Range Wi Unt Factory Defaut Value Modfication
FOLOD Main frequency input channel selection 03 1 [] [] o
FO1.01 Main frequency dgtal setup 0.00Hz"upper lmit frequency 00Hz 50.00Hz WH  |o
FO1.02 Mein frequency digtal control 000-111 (Oniy when FO1.00-0:3:4) 1 [ 0 o
FO1.03 Aupilary frequency input channel select 020 1 2 2 o
FO1.04 Audtary frequency digtal setup 0.00Hz"Upper lmit frequency 00THz 0.00Hz 00H o
FO1.05 Audiary frequency digtal cortrol o0 1 1 11 o
FOLOE Main and ausliary provide calculating setup 07 1 ] ] o
FO1.07 Audtary frequency provide cosfiicient 0.00~10.00 001 1.00 100 o
FO1.08 Coeffcient after complex of main and ausiary frequency 00071000 001 100 100 o
FO1.0% Auiiary frequency range selection o1 i ] [] o
FO1.10 Audiary frequency source scope 000100 o0 100 100 o
FO111 Upper limt frequency Low it frequency™~600.00Hz 001Hz 50.00Hz 00z |x
FO112 Low it frequency 0.00Hz"upper imit frequency D01Hz D4DHz Q4 [x
FO1.13 Low it frequency run mode 03 1 2 2 x
FO1.14 Sleep un hysteresis frequency 0.01Hz"upper imit frequency 001Hz 001Hz 001

FO1.15 Run command channel selection i3

FO1.16 Run direction setup
F01.17 Accelerstion ime 1
FO1.18 Deceleration time 1
Frequency Settings Operations Monitor Parameters.
50.00 i [E The inverter of device with 1D = 1 will respond to these commands Frequency:
- z
[ Fowarddog ||| START | [ FowardFun | Motor Speed:
SET [(Revemed0G ||[ s1oP | [ Revesefun | DC_BUS
3
Seral Port Seftings Run Information Current.
Current settings:
COM3 9600 Noe 81 START (iipatade:
p Output Power:
Open Pot Rotate Direction: Forward e
Fiefresh Rate fms]:

0000-1121
150000
1~60000
5.00 Hz
g Graph Setings
. Graph parameters
3202v
[ %
02A L ®
23V
0046 W

1000
1 Based on motortype 100 o
1 Based on motortype | 100 o
Meaning of modfication vaiues

x — Parameter cant be changed in process of nunring

0 — Parameler can be changed in process of unning

* — Read-only parameter, unmodiiable

o
b b & |
1 1000 o

m

JOG buttons will start the inverter in forward or reverse direction with set JOG frequency (default is 5.00 Hz)

Stop The Inverter

File Settings Help
System parameter groups
Fncton  paameter Name Set Rangs
FOO - Sysiem Parameters e
sic Fun Functions TS TR
FQ2 - Stat, Stop, Forward / Reverse, Brake ol s el i
FU3 - V/F Control F01.01 Main frequency digtal setup 0.00Hz"Upper I frequency
e L L FO1.02 Mainfrequency digtal cortrol 000-111 (Orly when FO1.00-0:3:4)
FI6 - Setling
Oy v i F01.08 Audiary frequency input channel select 020
FO2 - On/Of Input Functions FO1.04 Audiary frequency dgtal setup 0.00Hz"upper lm frequency
FU3 - On/Off Analog Output Functions
F10- Simple PLC/Mukispeed Functions F01.05 Ausdliary frequency dgtal control 0011
F11-Qose Loop PID Run Functions
e D A e 016 Main and ausliary provids calcuiating setup 07
F13.- Traverse /Foxed Length Cortrol Funciions | F01.07 Audiary frequency provide cosflicert 0.00-10.00
F14 - Vector Corfrol
F15.- Asynchronous Motor FO1.08 Cosflicient after complex of main and ausdiary frequency 0001000
I dedlow b FOL0S | Auilanyfrequency range selection 1
F19- Frotective Relevant Functions FO1.10 Audiary frequency source scope 000~1.00
F20 - Intemal Vitual Input Dutput Node
F25 - User Definion Display FOL1 Upperlimt frequency Lowlimit frequency™~600.00Hz
F2b - Falt Becond Funchors FO1.12 Low limit frequency 0.00Hz™upper limit frequency
F01.13 Lowlimit frequency run mode 03
FO1.18 Sleep run hysteresis frequency 0.0THz upperlmi frequency
FO1.15 Run command channel selection 02
F01.16 Run directon selup 00001121
F01.17 Acceleration time 1 160000
F01.18 Deceleration time 1 160000
Frequency Settings Operations Monitor Parameters. Table View
35.00 i) S | 5 e i i o e Frequency: 500 Hz © Graph View
= Hz @ Graph Seftings
Fornard JOG START Forward Fun Motor Speed: 150 RPM
SET [ﬁ [ﬁ Graph parameters
Reverse 0G I sToP I Reverse Aun DC_BUS: e
g - 0
, =
Sl Pt St T Current: 02A @
Current settings: :
e Output Voltage: 23v
ﬁ Output Power:  ooasw
Open Port Rotate Direction: Reverse o
Refresh Rate fms].

Min# Unit Factory Default Value

e e |

0.01Hz 50.00Hz 50.00Hz
1 [ 00

1 2 2
D.01He 0.00H 0.00H
1 il 1

1 2 0

001 1.00 1.00
001 100 1.00

i ] 0

001 100 1.00
001H: 50.00Hz 50.00Hz
0.01H: 040H: 0.40H:
1 7 2
0.0TH: 001H: 0.01H:
i 0 2

1 1000 1000

1 Based on motortype | 100

1 Based on motortype | 100

Meaning of modfication values
x — Parameter cant be changed in process of unring
0 — Paremeter can be changed in process of running

* — Read-only parameter, unmodiable

Modication |~

o

m

Click on STOP button to stop the running of inverter.

All monitor parameters except "DC_BUS" will fall to zero and Rotate Direction label will fade.




Graph View

EN500/600
File Settings Help
System parameter groups =
Funion  parameter Hame Set Rangs Mint Unit Factory Defaut Value Modfication —
F00 - System Paremeters e
T T — Main frequency input channel selsction 1
FO101 Mainfrequency digtal setup 0.00Hz"upper I frequency 0.01H: 50.00Hz 5000Hz o
FO4 - Adliery
FOB Tl G s Fisictirs F01.02 Mainfrequency dighal cortrol 000-111 {Orly when FO1.00-0:3:4) 1 ® [ o
FO§ - Setfing Curve > 5 =
kel M- FO1.08 Audlary frequency input ehannel select 02 1 2 2 o
-On/Off Input Functions FO1.04 Aulary frequency digtdl setup 0.00Hz"upper lmitfrequency 0.0TH: 0.00H: BOHz o
F08 - On/Off Analog Output Functions =
F10 - Simple PLC/Muti-speed Functions FO1.05 Audiary frequency digtl carirol 011 1 1 n o 3
F11 - Close Loop PID Fun Functions B
e e i [P0 Main and audiary provide calculating setup o7 1 [ ] o
F13 - Traverse/Fixed Length Cortrol Functions | F01.07 Audiary frequency provide coeficirt 00041000 001 100 100 o
F14 - Vector Cortrol
F15 - Asynchronous Motor FO1.08 Cosficient after complex of main and ausiary frequency 000~1000 001 1.00 1.00 o
F16 - Closed Loop Encod a
B Bl g F01.09 Ausdiary frequency range selection 01 1 ] [} o
F15 - Protective Relevant Functions FO1.10 Ausdliary frequency source scope 0.00~1.00 0.01 1.00 100 o
F20 - Intemal Vitual Input /Output Node L4
725 - User Defintion Display FOL1 Upper i frequency Low lmi frequency™600.00Hz 00MH: 50.00Hz 5000H:  |x
£25 Pl Hecord factons FO1.12 Low limit frequency 0.00Hz"upper limit frequency 0.01Hz 0.40Hz 040Hz  x
FO113 Low it frequency run mode 03 1 2 2 x
FO114 Sleep run hysterssis frequency 0.01Hz"upperImit frequency 0.0MH: 001H: 0H: o
FO1.15 Fun command channel selection 02 1 [ 2 o
FOL16 Run direction setup 00001121 1 1000 1000 o
FO117 Acceleration time 1 160000 1 Based on motortype 100 o
FO118 Decsleration time 1 160000 1 Based on motortype 100 o =
Frequency Settings Opersiions Monitor Parameters Mearing of modfication values
35.00 [ The inverter of device with 1D = 1 wil respond to thes commands Frequency: 35.00 Hz T AT R e R TR LY
2 Hz [¥] [Crowatw05.) [CsTART_] [LFowafun.) T 0o e Graph Settings — Parameter can be changed in process of nunring
SET Graph parameters * — Read-only parameter, unmodifiable
[_Revese oG | [ sT0P_ | [ RevereRun | DC_BUS g
(75
. |
Serial Pot Settings Run Infomation Current: 02A 9]
Current settings: Output Voltage: 154 v
COM4 9600.None 8.1 P 9¢
ﬁ -, Output Power: 0308w
Open Port Rotate Direction: Forward o
Refresh Fate fms]

Click on Graph View radio button to change the current view from table to graph.

EN500/600
File Settings Help
100% 360 — Freauency
DC BUS
= Current
Output Voltage
=— Qutput Power
80% 283
0% 216
o
5]
=
=
&
=
40% 144
20% 72
0% 0
0 1 2 3 4 5 3 i 3 9
Time Elapsed
Frequency Settings Operations Wonitor Parameters © Table View Meaning of modification values
35.00 E] The inverter of device with ID = 1 will respond to these commands. Frequency: 35.00 Hz © Graph View % — Parameter cant be changed in process cf unning
1 Hz .
[+] [ FowardsoG | [ START | [ FowerdFun | Motor Speed: ey Graph Settings 0 — Parameter can be changed in process of runring
*— Readorl parameler, unmodfatle
SET [ RevemesoG | [ S0P | [ ReveseRun | DC_BUS: e
[ P9
Senial Port Seftings Run Information Current: 02A [0}
Currert settings: .
COM4 9600 None,8.1 Output Voltage: 154 v
ﬂ | — Output Power: 0308w
Open Port Rotate Direction: Forward o
Refresh Rate [ms]

In this mode you can observe the trending chart of key parameter changes through specified time intervals (Refresh
Rate).



Stop Graph Timer

File Settings Help

100% 360 — Frequency
DC BUS
— Current
Output Voltage
— Qutput Power

80% 288

60% 216
8
z
=
=

40% 144

20% 72

0%
0 5 10 15 20
Time Hizpsed
Frequency Settings Operations Wonitor Parameters () Table View Meaning of modification values
35.00 o The inverer of device with ID = 1 wil respond to these commands. Frequency: 35.00 Hz © Graph View S T B T IS
. z . .
[ foward 06 [_stamT_) [_FomeriAin. S e Graph Settings 0 — Parameter can be changed in process of unning
* — Readory parameler, urmodiisble
SET [ Revemedog | [ sT0P | [ RevemeRun | DC_BUS: piav
(-5
Serial Port Settings Run Information Current: 02A » (0]
Guren e
s g START Output Voltage:  153v ps grap
ﬁ T w OutputPower:  0.306 W
T Rotate Direction: Forward o

Refresh Rate [ms]:

By clicking on the marked button you can pause the trending chart timer.

Start Graph Timer

File Seftings Help

100z 360 — Freauency
DCBUS
= Current
- Output Voltage
— Output Power

80% 288

60% 216
o
o
=
&
=

40% 144

20% 72

0% 0
0 5 10 15 20
Time Elapsed
Frequency Setings Operations. Moritor Farameters © Table View Mearing of modication values
35.00 @ The inverter of device with 10 = 1 wil respond to these commands. Frequency: 35.00 Hz 1@ Graph View % — Parameter cant be changed in process of running
. L= @ [ Forward JOG ] [ START ] [ T ] Motor Speed: 1050 RPM Graph Settings © — Parameter can be changed in process of running
SET * — Read-only parameter, unmodiiable:
[ Revemedog | [ s10P | [ ReveseRun | DC_BUS —
Current: 024 L
Serial Port Settings Run Information urrent: -
Cument settings: ¥ S
COME 9600 Nare 8.1 START Output Voltage: 153v
ﬁ [ — ] Output Power: 0306 W
Open Port Rotate Direction: Forward o

Refresh Rate [ms]:

By clicking on the marked button you can resume the trending chart timer.



Graph Parameters

EN500/600 Inverte
File Settings Help
100% 360 — Frequency
DCBUS
— Current
Output Voltage
— Output Power
80% 288
60% 216
=1
o]
=
=
e 144
20% 72
0% 0
0 5 10 15 20 25
Time Elapsed
Frequency Settings Operations Monitor Parameters ) Table View Mezrning of modification valuss
35.00 E The inverter of device with D = 1 will respond to these commands. Frequency: 35.00 Hz 1@ Graph View x — Parameter cant be changed in process of running
- Hz ™ [ Fowerd 406 [_START ] [ FomardFun_ Motor Speed: — Graph Seitings 0 — Parameter can be changed in process of running
SET [_Revened0G | [__stor_ | [_Reveseun | 55 A B3V | * — Read-orly parameter, unmodifiable
B 0=
Seril Port Setings Run Information Current: 02zA ®
Curment: settings -
COMZ 9600, None 8,1 Output Voltage: 153 v
| e ] Output Power: 0306w
Open Pot Rotate Direction: Forward o
Refresh Rate ms] 1000 -

Click on "Graph parameters" button to open the menu where you can choose parameters to be shown in the graph.

Note: data from trending chart is not logging anywhere, so after closing this menu the data tracking will be
restarted and the current record will be lost.

Graph Parameters Menu

-
ol Graph Parameters l‘:' =l g

Parameters to show

Frequency
DC BUS q!
Current

Output Voltage
Output Power

In this menu you can select parameters that you wish to be shown/not shown in the graph.

By default all 5 parameters are included into the graph view.

- ~
ol Graph Parameters l‘:' =l g

Parameters to show

Frequency
DCBUS [Fl
Current
Ouiput Voltage [
Ouiput Power [

Kl

Click OK button to apply the settings and go back to the main screen.



Note: data tracking will be restarted.

Refresh Chart

File Settings Help

100% = Frequency
= Current

80%
60%
0%
20%

0% - - T T T .

0 1 2 3 4 5 6

Time Elapsed

Frequency Settings Operstions Moritor Parameters ) Table View Mearing of modfication values
3500 (it [ vt o e w0 = 1 e respond to these commands. Frequency: 35.00 Hz @ Graph View e R e T R
: Hz
] [ 06 [starT] [Lronedin.) S L —— Graph Setings 0 — Parameter can be changed in process of running
e
SET [ Revesesos | [ stop | [ ReveseRun | DC_BUS: —
Current: 02A L
Serial Part Settings Run Information urrent: -
ELTT i Output Voltage: 154 v

COM4 9600,None. 8,1 START
= Output Power. 008w
e Rotate Direction: Foward (@
Refresh Rate fms]

Another way to refresh the tracking data in chart and begin the tracking again from 0 is by clicking the Refresh
button.

EN500/600 Inver
File Settings  Help

== Frequency

— Current
Frequency Setfings Operations Meritor Parameters Meaning of medfication values

3500 () The inverter of device with ID = 1 wil respond to these commands. Frequency: 35,00 Hz © Graph| Change from graph to table view PNt be changed in process of running

- Hz
] [Cronemios ) [CsTART_] [[Fowemn ) Motor Speed: 1050 RPM Graph Settings 0 — Parameter can be changed in process of running
SET * — Read-only parameter, unmodiable
[ RevenedoG | [ sTOP | [ RevemeRun | DC_BUS: e
Ci t: 02A L]
Senial Part Settings Run Information urren -
B Output Voltage: 153 v

COM4 9600.None 8.1
| Output Power: 0306w
Open Pot Rotate Direction: Forward e
P e ot

You can switch to table view again by clicking the Table View radio button.



Refresh Table

N:
File Settings Help
System parameter groups a
E‘;T"“” Parameter Name Set Range Minét Unit Factory Defauit Value Modification —
Fi em Parameters e
F02 - Start, Stop, Forward / Reverse. Brake bbb it et A il _
FO3 - V/F Cortral FO1.01 Main frequency digtal setup 0.00Hz"upper imt frequency 0.01He 50.00Hz 00z o
F04 - Ausdliary Running
FO05 - Temin Comebaivi Firictiorss FO1.02 Main frequency digtal control 000-111 {Only when F01.00-0:3:4) 1 L ® o
FO6 - Setting Curve =
e s e st FO1.03 Ausdiary frequency input channel select 020 1 20 2 o
F08 - On/Off Input Functions FO1.04 Ausdiary frequency digial setup 0.00Hz"upper limt frequency 0.01H 0.00Hz 0k o
FU - On/Off Analog Output Functions - =
F10 - Simple PLC/Muki-speed Functions FO1.05 Ausdiary frequency digital cortrol 0011 1 1" 1 o 3
F11 - Close Loop PID Run Funcions F : =
F12- ot Prcoors Woter Somgly Fuctiors || FU106 Main and audiary provide calculsting setup 07 1 0 0 o
E13: Tavoras e Longth Corirel ot Brur 07 #usdiary frequency provide cosfficient 00071000 o001 100 100 o
- Vector Control
F15 - Asynchronous Motor FO1.08 Cosfficient after comples of main and auliary frequency 0.00710.00 o001 100 100 o
F16 - Closed Loop Encodk
e D i, FOL.09 Audiry frequency range selection 01 1 0 [} o
F15 - Protective Relevant Functions FO1.10 Musdliary frequency source scope 0.00~1.00 001 100 1.00 °
F20- Intemal Virtual Input/Outout Node L4
F25 - User Definttion Display Fo1.11 Upper limit frequency Low limit frequency~600.00Hz 0.01Hz 50.00Hz 50.00Hz x
F28Fouk Hacor Frmctors FO1.12 Low imt frequency 0.00Hz"upper limit frequency 0.01Hz 0.40Hz 040Hz  x
FO1.13 Low mt frequency run mode 03 1 2 2 x
FO1.14 Sleep run hysteresis frequency 0.01Hz"upper imt frequency 001He 001Hz WiH o
FO1.15 Run command channel selection 02 1 0 2 o
FO1.16 Run direction setup 0000-1121 1 1000 1000 o
FO1.17 Acceleration fime 1 160000 1 Based on motortype | 100 o
FO1.18 Deceleration time: 1 160000 1 Based on motortype | 100 o =
Frequency Settings Operations Montor Parameters Meaning of modfication values
35.00 E The inverter of device with ID = 1 will respond to these commands. Frequency 35.00 Hz ) Graph View x — Parameter cant be changed in process of nunning
2 Hz . sk
v [Lfowad 06 ) [L_START. ] [ Fowad i) et ] Graph Setings 0 — Parameter can be changed in process of runring
SET r— Graph parameters * — Read-orly parameter, unmodifiable
[ Revenedog | [ stoP | [ RevemeFun | DC_BUS e
0
|
Seral Port Setings Aun Infomation Current: RN 9]
Curmrent seftings -
e Output Voltage: 153 v
ﬂ | e | Output Power: 0306w
Open Port Rotate Direction: Forward e
Refrosh Rate fms]:

In table view, you can reload all the parameters from the chosen system parameter group by clicking Refresh

button.

You can also do it by clicking again on the chosen system parameter group in the list box.

Save Template

E‘;::"’” Parameter Name Set Range Miné? Urit Factory Default Value Modification —
ey ) |
FO1.01 Main frequency digtal setup 0.00Hz"Upper I frequency 00MH: 50.00Hz 000z o
s F01.02 Msin frequency digtal control 000-111 (Oniy when FO1.00-0:3:4) 1 00 00 o
FO6 - Setting Curve - 3
il I FL03 Ausdiery frequency input channel select 020 1 2 2 o
FO8 - On/OF Input Functions FOL.04 Audiary frequency digial setup 0.00Hz"Upper it frequency 00MH: 0.00Hz 000H o
F0S - On/Off Analog Output Functions =
F10- Simple PLC/Mukispeed Functions FO1.05 Audlary frecuency diotal control w1 1 11 11 o 3
F11-Close Loop PID Run Functions 5
L b s i Rl [T Main and aLsdiary provide caleuiating setup 07 1 0 0 o
F13- Traverse/Fired Length Cortrol Functions | F01.07 Ausdiery frequency provide coeficient 0.00~10.00 oo 100 100 o
F14 - Vector Contro
F15 - Asynchronous Motor Fi.08 Coeficent after complex of main and audiary frequency 00071000 o 100 0 o
o ediy Bt FIT09 Ay frequency range selection [3] 1 0 0 o
F19 - Protective Relevant Functions FO.10 Audiary frequency source scope 000-1.00 [T 100 100 o
F20- intemal Virual Input/Ovtput Node |
F25 - User Defntin Display FOLI Upper it frequency Low imt frequency™600.00Hz 00MH: 50.00Hz 5000H  |x
E26 Fat Focord Hecins FO1.12 Low limi frequency 0.00Hz~upper mit frequency 00TH: 0.40Hz 040Hz  |x
FO1.13 Lowlimt frequency run mods 03 1 2 2 x
FOL14 Sleep run hysteresis frequency 0.01Hz"Upper it frequency 00H: 001H: 00 o
FO1.15 Fiun command channel selection 02 1 0 2 o
FO1.16 Run drection setup 00001121 1 1000 1000 o
FO1.17 Acceleration time 1 160000 1 Based on molortype 100 o
FO1.18 Deceleraton time 1 160000 1 Based on molortype 100 o .
Frequency Settings Operations Moritor Parameters Teble View Mesning of modfication values
35.00 E] The inverter of device with ID = 1 will respond te these commands. Frequency: 0.00 Hz ) Graph View % — Parameter cant be changed in process of unning
d Hz ) ([ Foward 06 [_5TART ] [ Fowerd i Motor Speed: 0 FeM Graph Settngs o — Parameter can be changed in process of unring
= Graph parameters * — Read-only parameter, unmodifiable
_ [ Revemsoc | [__sT0P_] [ Revenefin | DC_BUS 223V
]
|
S Fort Seliwige Fuoitmste Current: 00A L @
Current sefings: Output Voltage: ov
COM4 9600, Nane 8.1 2 9e:
p - Output Power:  ow
Refresh Rate fms]:

You can save all the current values of inverter parameters as a template file, that you can later reload.

By clicking on File -> Save Template... button or by pressing Ctrl+S shortcut on your keyboard, browse

should open.

window




-
ENC Select a Template File

uu | . <« Visual Studio 2015 » Projects » EMN500-600 Inverter » EN500-600 Inverter » bin » templates

- | +3 | | Search templates

UEq
= Recent Places

. Libraries
@ Documents
ds Music
[ Pictures

¥ videos

m

1M Computer
&, Local Disk (C)
= Local Disk (D)

uments library

Organize » Mew folder
-
0 Favorites — Doc
M Desktop termnplates
& Downloads Maine

7] Allow communication via app

| Maintaining Constant Pressure (Pump)

Date modified

231.20191517
24.1.2019 11:06

Arrange by:  Folder =
Type Size
ENCTMP File TKB
ENCTMP File TKB

File name: guide

-

Save as type: | ENCTMP File

)

'~ Hide Folders

[ sae k” Cancel |

Enter the desired file name and click on Save button to generate the new template (with .enctmp file extension).

Note: because of the security of data transmission, estimated waiting time for this process is about 30 seconds due
to the write timeout of the serial port.

r M
Information ﬂ
@ Template guide has been successfully saved.
A

You'll be notified when the process of saving template is finished.

Load Template

Load Template... Ctrl+L v
ook Parameter Name
Save Template..  Ctrl+S <
Main frequency input channel selection
G Bt Ctrlex
FO1.01 Main frequency digtal setup
F04 - Ausdiry Running
FO5 - Teminal Conelative Functions FO1.02 Main frequency digital control
FO6 - Seting Curve
FO7 - Analog, Pulse Input Functions i Onlpbrsires ol den sl
F08 - On /O Input Functions FIL04 Ausdiary frequency digital setup
F09 -On/CF Analog Output Functions
F10 - Simple PLC/Muti-speed Functions FO1.05 Ausdliary frequency digital control
F11 -Close Loop PID Run Functions
T o Eerme Mo S Funcions || P16 Main and ausdiary provide calculating setup
F13- Traverse/Fured Length Control Functions | F01.07 Ausdiary frequency provide coeficient
F14 - Vector Control
F15 - Asynchnonous Motor FO1.08 Coeffcient after complex of main and audiary frequency
T i By it FIT09  Audiay frequency range selection
F19 - Protective Relevant Functions FO1.10 Audiary frequency source scope
F20- intemal Vitual Inout/Octput Node
F25 - User Defntin Display FOiL1 Upper it frequency
F26 -Fault Record Functions i P
FO1.13 Low lim frequency run mode:
FO1.14 Sleep run hysteresis frequency
FO1.15 Run command channel selection
FO1.16 Fun drection setup
FO1.17 Accelerstion time 1
FO1.18 Deceleration time 1
Frequency Settings Operstions Montor Parameters
3500 i [ | e e o o 5 = T i e s s commrei Frequency:
- z
[+) [ Fowaddoc | [ sTART | [ FowadRun | Motor Speed:
[ Revems 0G| [__sT0P_] [ Reverse fun | DC BUS
S Pt Sctiwigs Fiiasie Current:
LN selitar Output Voltage:
COM4 9600.Nore,8.1 STOP 2 96
ﬁ = Output Power
O
Refresh Rate imsl

Set Range

0.00Hz"upper lmit frequency
000-111 (Only when FO1.00-0:3:4)
020

0.00Hz"upper it frequency
0011

07

00071000

00071000

L3l

0.00-1.00

Low limit frequency~600.00Hz
0.00Hz"upper imit frequency

03
0.01Hz"upper imt frequency
02
0000-1121
160000
160000
© Table View
0.00 Hz ) Graph View
T Graph Setings
= Groph parameters
234V
[
00A o ®
ov
ow

Miné® Urit Factory Default Value Modification
T S S S
001 5000H: 5000H: o
1 00 0 o
1 2 2 o
001 0.00H: 00t o
1 1 1 o 3
1 0 [ o
0ot 100 100 o
001 100 100 o
1 0 [] o
001 1.00 1.00 o
001H: 5000H: 500H  x =
001 0.0 040t |x
1 2 2 x
001 001 00 o
1 0 2 o
1 1000 1000 o
1 Based on mtortype 100 s
1 Based on motortype 100 o 2

Meaning of mediication values

x — Parameter can! be changed in process of running

o — Parameter can be changed in process of unring

* — Reathonly parameter, unmodiable

You can load the previously saved template by clicking File -> Load Template

your keyboard.

.. or by pressing Ctrl+L shortcut on




Browse window should open.

-
ENC Select a Template File
Vgl

S

e/ | | s Visual Studio 2015 » Projects » ENS00-600 Inverter »

EM500-600 Inverter » bin » templates

o

- | 3 | | Search templates

@ Documents

Aﬁ Music

[ Pictures

E Videos

M Computer
&, Local Disk (C:)
—w Local Disk (D:)

“! MNetwork

File name: Allow communication via app

Organize = New folder =« 0 @
3¢ Favorites Documents library g by Rt

B Desktop templates

& Downloads MName : Date modified Type Size

=] Recent Places

| Allow communication via app 23.1.201915:17 ENCTMP File TKB

=3 Libraries 7] guide 251.201915:30 ENCTMP File TKB

: | Maintaining Constant Pressure (Pump) 241.201911:06 EMNCTMP File TKB

~ [ENCTMP File -

I Open %ﬂ [ Cancel ]

Select the certain .enctmp file and click on "Open" button to load all the parameters to the inverter.

Note: because of the security of data transmission, estimated waiting time for this process is about 30 seconds due

to the read timeout of the serial port.

-
Information

[

0 Template Allow communication via app has been loaded successfully.
k- =

You'll be notified when the process of loading template is finished.

Reset to Factory Default

File Settings
System parameterg [ Tutorial »
Parameter Name Set Range Mintt Unit Factory Defaut Value Modfication —
FO0 - System Perem| & User Manual
FO1 -Basic Fun Furl 5 z
F03- V/F Control Main frequency digtal setup 0.00Hz"upper it frequency 00H: 50.00Hz 5000H:  |o
FO4 - Aucliary Runr§ ) Reset to Factery Default
F05 - Temingl Con-=Feeremens Main frequency digtel control 000-111 Oniy when FO1.00=0:34) 1 i) [ o
F05 - Setting pe
st I FO1.03 Ausdlary frequency input channel select 020 1 2 2 o
F08 - On/OF Input Functions FO1.04 Ausdlary frequency digtal setup 0.00Hz"Upper Imt frequency 001H: 0.00H: 00H: o
F03 - On/OF Analog Output Functions C
F10- Smple PLC/Mutispeed Functions FO1.05 Ausdlary frequency digtal control wn 1 " n o
F11 -Close Loop FID Run Funcions 0
oy s i Main and ausdiary provide calculating setup 1% 1 [ 0 o
E13; Teverse Fend Lovith Cortrl Pt (007 Audlary frequency provide coeficient 0001000 o 100 100 o
~Vector Contro
F15 - Asynchronous Motor FO1.08 Coeffcient after compler of main and audiary frequency 000-1000 (L1 1.00 1.00 o
F16 -Closed Loop Encodk -
e FO1.09 Ausdliary frequency range selection L8] 1 ] 0 o
F18 - Protective Relevart Functions FO1.10 Aundliary frequency source scope 0.00~1.00 001 100 1.00 o
F20 - Intemal Virtual Input/Otput Hode: 4
F25 - User Defintion Dispiay FO1.11 Upperlimt frequency Low fimt frequency "600.00Hz 00H: 50.00H 50004 |x
HE et FO1.12 Low lm frequency 0.00Hz"upper it frequency 001Hz 040Hz Dd0H  |x
FO1.12 Low lim frequency un mode [H 1 2 2 x
FO114 Sleep run hysterasis frequency D.01Hz"upper Imt frequency 001H: 0.01H: 00 o
FO1.15 Run command channel seiection 02 1 o 2 o
FO1.16 Run drection setup 0000121 1 1000 1000 o
FO1.17 Acclerstion time 1 1~60000 1 Based on motortype 100 o
FO1.18 Deceleration time 1 150000 1 Based on molortype | 100 o -
Frequency Settings Opergtions Montor Parameters Table View Meaning of medfication values
35.00 ] S | i e o e wa = e s i Frequency: 0.00 Hz © Greph View x — Parameter cant be changed in process of running
2 Hz [¥] [rowaruoe ] [L_stART_] [ Fowad A Motor Speed: 0 RPM Graph Settings 0 — Parameter can be changed in process of runring
SET Graph parameters * — Read-only parameter, unmodifiable
[ Revemedos | [ stoP ] [ RevemsRun | DC_BUS g
L=
. |
Serial Port Settings Flun Irfomation Current: 00A L @
Current settings: Output Voltage: ov
COM4 5600.Nore, 2.1 STOP P o€
ﬁi = Output Power: 0w
Open Port
Rt

If you wish to restore all the parameters to the factory settings go to Help -> Reset to Factory Default.




This process will take few seconds.

-
Consent

=

You'll be prompted if you're sure about your choice.

-
Information

=

All parameters of inverter with ID = 1 are reset to factory default.

b

You'll get the confirmation that the process of reverting all parameters to factory default is accomplished

successfully.

Inverter ID Settings

Min# Unit Factory Defauft

Value

0.01Hz 50.00Hz 50.00Hz
1 00 00

1 20 20
0.01Hz 0.00Hz 0.00Hz
1 1 1

1 0 L}

001 1.00 1.00
00 1.00 1.0

1 0 0

001 1.00 1.00
0.01Hz 50.00Hz 50.00Hz
0.01Hz 0.40Hz 0.40Hz
1 2 2
0.01Hz 0.01Hz 0.01H
1 0 0

1 1000 1000

1 Based on motortype 100

1 Based on motortype 100

Meaning of modfication values

* — Parametar cant be changed in procsss of running

© — Parameter can be changed in process of unning

Fungton  parameter Name Set Range
Weain fre i charmel selecti
F02 - Start. Stop, Forward / Reverse. Brake acttsnli el =t
FU3 - V/F Conirol FOL01 Meain frequency digtal setup 0.00Hz"Upper mit frequency
FO4 - Ausdlary R
FO5 L T G Firictorss FO1.02 Main frequency digtal control 000-111 Ony when FO1.00=0:34)
F06 - Setting Curve
D e s FO1.03 Ausdiary frequency input channel select 020
F08 - On /G Input Functions FO1.04 Ausdiary frequency digital setup 0.00Hz"Upper It frequency
F09 - On/Off Analog Output Functions
F10 - Simple PLC/Muttispeed Functions FO1.05 Aundliary frequency digital control 0o-1
Fi1 -Close Loop FID Run Functions -
s e roie Main and ausdiary provide caleulating setup ]
F13- Traverse/Fuied Length Cortrol Functions | F11.07 Audiary frequency provide cosficient 00071000
F14 - Vector Cortrol
F15 - Asynchronous Motor FO1.08 Coefficient after complex.of main and sudiary frequency 0.00~10.00
F16 - Closed Loop Encod
i e FO1.09 Ausdliary frequency range selection (Y]
F13 - Protective Relevart Functions FO1.10 Audliary frequency source scope 0.00~1.00
F20- intemal Virtual Input/Output Node
F25 - User Defintion Display FOL1 Upper it frequency Low imi frequency~600.00Hz
R FO1.12 Low imt frequency 0.00Hz"upper i frequency
FO1.13 Low it frequency run mods 03
FO.14 Sleep run hysteresis frequency 0.01Hz"Upper I frequency
FO1.15 Run command channel selection 02
FO1.16 Run direction selup 00001121
FI1.17 Acceleration time 1 1~60000
FO1.18 Deceleration time 1 1~60000
Frequency Seftings Operations Monitor Parameters Table View
50.00 i3] N | et o e vai = e et e commeret Frequency: 0.00 Hz Graph View
2 Hz Graph
[¥] [ FowarddoG | [ START | [ Foward Aun | Motor Speed: 0 RPM ieph Settings
SET Fevere R Graph parameters
[ Revemedos | [ stoP | [ RevemeRn | DC_BUS: T
O
. |
Serial Port Settings Run Infommation Current: HEA L ®
Current settings: o
COM4 9600.Nore 8.1 Rl ge o v
ﬁ _—— Output Power.  ow
Open Por
Refresh Rate fms]:

* — Read-only parameter, unmodfiable

Modication |-

m

This setting should allow user to switch between different inverters connected to this PC.

Note: this feature is not supported in version 1.0




User Manual

File  Settings | Help
System parameterd [0 Tutori
Perameter Name
FOO - System Parsmfl & User Manual
Main frequency digtal setup
) Reset to Factory Default
! B Main frequency digtal cortrol
FO6 - Setting Curve -
i FO1.03 Ausdiary frequency input channel sefect
FOB - On/OF Inpu Functions FO1.04 Audiary frequency digital setup
F09 - On/OFf Analog Output Functions
F10 - Smple PLC/Muki-speed Functions FO1.05 Auclizry frequency digital control
F11 - Close Loop PID Aun Functions
e i s e [JF0i0e Main 2nd azdiary provide caleuiating setup
F13- Traverse/Ficed Length Carirol Functions | F01 07 Ausdiery frequency provide cocficient
F14 - Vector Cortrol
F15 - Asynchronous Motor Fi.08 Coeficient after complex of main and audiary frequency
o ediy Bt FIT09 Ay frequency range selection
F19- Protective Relevant Functions FO.1D Ausdliary frequency source scope
F20- intemal Vitual Inout/Output Node
F25 - User Diefnton Display FOLI Upper it frequency
F26 - Fault Recond Functions = PR
FL13 Low limt frequency run mode
FOL14 Sleep run hysteresis frequency
F1.15 Run command channel selection
F.16 Run drection setup
FL17 Acceleration time 1
F.18 Deceleration fime 1
Frequency Seftings Operations
50.00 i L e o et s 2 e e e o e
- z
(¥] [ FowarddoG | [ START | [ FowardFun |
SET [ RevesedoG | [ _5TOP_| [ RevemeRun |
Serial Port Seftings Fun Irfomation
Curent setiings:
COM4 9600 Nere &1 STOP

Moritor Parameters
Frequency:

Motor Speed:
DC_BUS

Current:
Output Voltage:
Output Power.

Refresh Rate s}

0.00 Hz
ORPM
3224V
00A
v

ow

Set Range

0.00Hz"upper imit frequency
000-111 (Only when FO1.00-0:3:4)
020

0.00Hz"upper imit frequency
011

07

00071000

00071000

(3

0.0071.00

Low limit frequency~600.00Hz
0.00Hz"upper imit frequency

03

0.01Hz"upper imit frequency

02

00001121

160000

160000
Table View
Graph View

Graph Settings
Graph parameters

Min#t Unit Factory Defaut Value

001Hz 50.00Hz 50.00Hz
1 00 00

1 2 2
001Hz 0.00Hz 0.00H
1 il il

1 ] 0

oo 1.00 1.00
on 1.00 00

1 ] 0

o 1.00 1.00
001He 50.00Hz 50.00Hz
001He 040H: 0.40H:
1 2 2
001Hz 001Hz 001H
1 ] 0

1 1000 1000

1 Based on motortype | 100

1 Based on molortype | 100

Meaning of mediication values
x — Parameter can' be changed in process of runring
o — Parameler can be changed in process of unring

* — Read-only parameter, unmodfible

Modfication

Vi oy pc chomnelsocion N T YN

o

o

o

m

Click on "User Manual" button to open PDF documentation for EN500/600 inverter.

Guide

File Settings | Help

System parameter | [0 Guide »
Parameter Name Set Range Mintt Unit Factory Defaut Value Modfication —
< & User Manual
e——— e ===
Main frequency digital setup 0.00Hz"upper limit frequency 001Hz 50 00Hz 000H: (o
Reset to Factory Default
e Main frequency digtal control 000-111 Oniy when FO1.00-0:34) 1 i) [ o
st A FO1.03 Ausdlary frequency input channel select 020 1 2 2 o
F08 - On/OF Input Functions FO1.04 Ausdlary frequency digtal setup 0.00Hz"Upper Imt frequency 001H: 0.00H: 00H: o
FO3 - On/Off Analog Output Functions =
F10 - Simple PLC/Mutispeed Functions FO1.05 Aundliary frequency digital control o011 1 n n o
F11 -Close Loop FID Run Funcions 0
F12Congent Presuns Wotes Soppiy Functions || 70108 WMain and aucdiary provide calculating setup 07 1 0 o
E13; Teverse Fend Lovith Cortrl Pt (007 Audlary frequency provide coeficient 0001000 o 100 100 o
~Vector Contro
F15 - Asynchronous Motor FO1.08 Coeffcient after compler of main and audiary frequency 000-1000 (L1 1.00 o o
F16 -Closed Loop Encodk -
e FO1.09 Ausdliary frequency range selection L8] 1 ] 0 o
F18 - Protective Relevart Functions FO1.10 Aundliary frequency source scope 0.00~1.00 001 100 1.00 o
F20 - Intemal Virtual Input/Otput Hode: 4
F25 - User Definition Display Fo1.11 Upper limit frequency Low limit frequency~600.00Hz 0.01Hz 50.00Hz 50 00Hz x
HE et FO1.12 Low lm frequency 0.00Hz"upper it frequency 001Hz 040Hz D40H  |x
FO1.12 Low lim frequency un mode [H 1 2 2 x
FO114 Sleep run hysterasis frequency D.01Hz"upper Imt frequency 001H: 0.01H: 00 o
FO1.15 Run command channel selection 02 1 o 2 o
FO1.16 Run direction setup 0000-1121 1 1000 1000 o
FO1.17 Accelerstion time 1 1~60000 1 Based on motortype 100 o
FO1.18 Deceleration time 1 150000 1 Based on molortype 100 o -
Frequency Settings Operations Moritor Parameters. Table View Mezaning of mediication values
0.00 E] The inverter of device with ID = 1 wil respond to these commands. Frequency: 0.00 Hz Graph View * — Parameter cant be changed in process of unning
2 Hz [¥] [Lroweruoe ] [L_stART_] [ Fowad A Motor Speed: 0 RPM Graph Settings 0 — Parameter can be changed in process of runring
SET [ Revemedos | [ stop | [ RevemsRun | DC BUS: s LSt e * — Read-only parameter, unmodfiable
B ) [
. |
Serial Port Settings Flun Irfomation Current: 00A L @
Current settings: Output Voltage: ov
COM4 9600.Nare 2.1 i g€
ﬁ = Output Power: 0w
Open Port
Refresh Rate fms]

To open this guide go to Help -> Guide in menu bar.




Support

Contact

Contact: igor@sah.rs

Website: www.sah.co.rs

For all questions, suggestions and advices write to igor@sah.rs or visit the official company website www.sah.co.rs
This is the first version of software and it's not fully tested so it may have some malfunctions or bugs.

If you notice some of them, feel free to leave the feedback so we can fix it in later releases.

Sincerely,

Igor Filipovic (SAH Electronics Belgrade)
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